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 1. Introduction  

This guide is intended for end-users with the following objectives:

The version of driver documented in the current User Guide is the setup version 6.8.1.181.

The .pkg file is available on Evolis support website.

Evolis printers that are managed by the driver are the following:  
· Primacy 1, Primacy 2, Zenius, Elypso, KC100, KC200, KM500B,  KM2000B
· Badgy100 and Badgy200
· Edikio Access, Duplex and Flex
· KC Essential/KC Prime

  Features of the driver may vary depending on the type of printer you use. 
  Evolis printers have more or less possibilities depending on their type.
  This User Guide describes all possible features offered by the range of printers listed
above. 

 
 2. Copyright and Trademark  

© Evolis. All rights reserved.
Users must observe the copyright regulations applicable in their country. This manual must not be
photocopied, translated, reproduced, or transmitted, in whole or in part, for any reason and by any
electronic or mechanical means whatsoever without the express written consent of Evolis.
All the information contained in this document is subject to change without prior notice.
Evolis cannot be held liable for any loss or damage arising accidentally or as a result of dissemination
or use of this manual.

Driver Setup® and Evolis High Trust® are trademarks of Evolis. All other trademarks belong to their
respective holders.

 
 3. How To Use This Guide  

 
 3.1   Informative Icons  

The following icons are used in this manual to highlight important information:

Information providing further details or depth about specific points in the main text of
the guide.

Warning
Actions that are prohibited or dangerous to the product (loss of data, for example) or
the user (safety matter, for example).

The term attached to this icon has a definition in the glossary provided in the present
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guide. 

USE CASE Examples of use cases are provided throughout this user guide. 
They will help you understand how to use Driver Setup and print your cards the best
way.

Indicates that a video showing the procedure is available on www.evolis.com website.

 
 3.2   Glossary  

Term MEANING

Anti-aliasing Type of smoothing technique that is specifically focused on text areas and
pictures. This settings is only available in Evolis card design softwares
(Cardpresso, Badge Studio, Edikio Price Tag).

Black dot Dots of the design that have RGB colors <253  and are printed with the K panel
only.

The threshold detected by Evolis driver for black and colored dots is RGB 253. 
Colored dots have RGB color ≥253 and are printed with the YMC panels.

If necessary, this threshold may be changed in your card designing software. 

Clustered
dithering

Halftoning technique that converts a color image to one made up of group of
dots. 
It produces a good quality image rendering at distance

Composite
Black 

Process used to print the black color with a mix of colors: yellow, magenta and
cyan

Dithering Halftoning technique in which dots or pixels arrangement allows to perceive
more colors than are actually used. 

dpi (dot per
inch)

Number of dots that are placed in one inch on a card design. 

Duplex Mode linked to a printer equipped with a flip-over module
Automatic front and back-side printing is possible

Dye
sublimation

Printing process in which ink is transformed in gas and spread on the card surface.
Dyes of three separate color panels (YMC or Yellow, Magenta, Cyan) are used to
create millions of colors within the spectrum, from white to (non-pure) black. 
Printing quality is dependent of the card quality, plastic composition and density.

Encoding Process to save data on a specific support (magnetic stripe, contact/contactless
chip). 
No confusion should be made with the term "encryption".  



User-Guide_EvolisDriver_Macintosh_ENG_2021123 
  

                                                                                                                                            6 

Term MEANING

Some encoding systems are called "dual" : it means they offer contact as well as
contactless encoding
CL means "contactless"
CNT means "contact"

Encryption Process to replace data by another data that can be encrypted/decrypted
through a specific key. 

For example, the key may be as follows: replacing the letter by the letter +2 in
the alphabet: A=C, B=D, C=E, D=etc. 

Halftoning Process that simulates shades of gray by varying the size of tiny black dots
arranged in a regular pattern (only available with a black ribbon)

Hologram Advanced form of photography that allows an image to be recorded in three
dimensions

LCD
(Liquid
Crystal

Display )

Color touchscreen attached to the Primacy printer that informs the user about
the operational status of the printer and enables to change the most common
settings. It also includes a switch on/off button to command the printer. 

Native Driver Simplified printer driver that is displayed and available by default through the
computer Control Panel or directly from an application. 
CUPS on MACINTOSH® 

Native driver
printing
settings

Evolis graphical interface of the native driver, available in all three modes but
particularly useful in Minimal Mode. 
The list of settings in this interface is limited, but they are the default settings
when the printing job is not performed from an application with embarked
settings

Overlay /
Varnish

Film applied on the card after the printing process, to protect the card from UVs
and to increase resistance of cards to scratching and fading up. 
It is applied through the "O"panel of the ribbon. 

Panel In a ribbon, sequence of colors that is repeated. 
The sequence of colors depends on the type of ribbon used. 
For example, in a five-panel ribbon, the colors are the following: yellow,
magenta, cyan, black, overlay

PC/SC Standard for smart cards and card readers.
A smart contact card is a CR80 card with an integrated circuit.

Printing Process made by the printer to apply the design on the card.
Various techniques are used:
- dye sublimation combined and thermal transfer
- retransfer (only possible with Evolis retransfer printers)

Ribbon Ink support film made of various panels or a continuous one, depending on the
ribbon type. The film support can be a cassette or simple rolls. 
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Term MEANING

With Evolis High Trust® ribbons, a zone code provides authentication and
identification of each ribbon. 
During the printing process, dye sublimation and thermal transfer techniques are
used.

Simplex Printer with no flip-over module integrated or activated.
Front and back-side printing is possible, but the back-side print requires a
manual action of the user

Smoothing Technique used to make more even the curbs on the pattern, so as to get a
clearer print rendering on the card. 

Thermal
transfer

Printing process in which ink is heated up to produce plastic resin and transferred
onto the card surface. K (black) and O (overlay) panels are applied through this
technique. 
For example, monochrome resin is applied on a YMC color design to produce a
dense black text or a barcode. 
Card quality is less critical than for the dye sublimation process. 

Varnish
(used for

lamination)

Type of lamination film available in a thickness that enables a two-year durability
of the card
This type of film: 
- covers the full surface of the card (edge-to-edge covering)
- is compatible with PVC or composite cards
- is not compatible with smart contact cards or magnetic stripe cards

YMCKO Type of ribbon that contains the following panels: Yellow, Magenta, Cyan, Black,
Overlay
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 4. Minimum Requirements  

 OPERATING
SYSTEM

MacOS 11 (Big Sur)
MacOS X 10.15 (Catalina)
MacOS X 10.14 (Mojave)
MacOS X 10.13 (High Sierra)
MacOS X 10.12 (Sierra)

AVAILABLE SIZE
ON DISK ≥ 13,2 MB

FIRMWARE Last firmware available on Evolis website

The driver and the firmware applicable to your printer are closely
linked.

Please always make sure that the firmware installed on your
computer is up to date.

RIGHTS Administrative rights are compulsory on your computer. 

NETWORK
OPTIONS

USB, Ethernet or Wi-Fi connection (refer to section Configuration of the
Connection) 16

https://fr.evolis.com/
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 5. Possible Configurations  

Some printers managed by the driver have a USB port as well as an Ethernet port and some of them
have a USB port only (Badgy 100/200 and Edikio Access).
Only Primacy printer has an additional Wi-Fi option. 

The type of port used is different according to the configuration:

- one printer on one computer

- various printers on the same computer

- printer shared between various computers

- through a switch: one or various printers with the Ethernet connection, on the same computer or
various computers

For more details on the installation and configuration steps, see section Configuration of the
Connection .16
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 6. Driver Installation  

Please refer to section Minimum Requirements before starting the installation.

Plug the printer to the computer and make sure you are logged with the administrator rights.

 
 6.1   Finding the Driver Setup File  

Step 1: Go to the Evolis website, click on Drivers&Supports and select the printer that you are
currently using, then click on Drivers&Firmware. 

The driver setup file may also available on the CD-ROM/USB stick you were provided in
the packaging of the product you have purchased from Evolis. 
However, when you want to install the last version of the driver setup, you need to
download it from Evolis website as explained in the first steps. 

Evolis Printer Driver is made available through a .pkg file.

Step 2: Click on the link called Setup Version to download it. 

Step 3: Go to next section to run the wizard.  

 
 6.2   Checking Your Current Driver Version  

Before you decide to change the driver on your computer, you can check your current driver setup
version as follows:

Step 1: Click System Preferences in the Apple menu.

Step 2: Click Printer & Scanners.
Select the printer in the list and check the version on the right part:

https://fr.evolis.com/
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 6.3   Running the Installation Wizard  

Step 1: From the file explorer, right-click on the .pkg file to open it.

 If the following error message appears:

Hold the command key while clicking on the file and click on Open:

 

Step 2: Run the wizard to install the CUPS driver. 
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Step 3: Plug-in your printer power supply to the mains socket .
From the wizard, click on Continue. 
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Go to next steps:
- USB Connection  and Assigning the Driver Version  
- or LAN Connection  and Assigning the Driver Version

16 25

16 25



User-Guide_EvolisDriver_Macintosh_ENG_2021123 
  

                                                                                                                                          14 

 
 7. Installing Evolis Color Profile  

Step 1: Go to Applications>Utilities>ColorSync Utility.

Step 2: From the list on the left, click on the printer. 

Step 3: Click on Current Profile and select Other to assign the profile.  

Step 4: Search for the profile in the following path:
System>Library>ColorSync>evolis_profil_v701.icc
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Step 5: The profile is now assigned to the printer. 
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 8. Configuration of the Connection  

This section explains how to configure your printer(s) and computer(s) through different types of
connections (point-to-point or network) and communication (USB, Ethernet, Wi-Fi).

You may have some additional information in the following document: Network Administrator
Manual.

 
 8.1   USB Connection  

This type of connection is the most frequently used. 

You can use it with:
- one printer

- various printers: depending on the number of USB ports on your computer

If you use a USB switch, please be aware that all models are not supported by Evolis
configurations today. 

 
 8.2   LAN Connection  

This type of connection uses Ethernet ports and cables. 

It is used when a printer is shared on various computers, or various computers use share the same
printer.

https://www.evolis.com/sites/default/files/drivers/58040_1249305_Network_administrator_manual_KU034_ENG_A1.pdf
https://www.evolis.com/sites/default/files/drivers/58040_1249305_Network_administrator_manual_KU034_ENG_A1.pdf
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 8.2.1.    Checklist Before Starting  

· Do not plug at the same time the USB cable and the network cable. 

· Firewall and Antivirus : must be set to authorize communication on port 9100 (Evolis raw
printing port). You must have at least “power user “rights to perform Evolis network printer
installation.

· IPV4 protocol: Evolis printer is compliant with IPV4 communication protocol only (not IPV6). 

· Multicast: pay attention that the protocol used to discover the printer on a network is
multicast so then the routing table on your network equipment (router, server …) must be
configured accordingly to your network architecture to allow communication. 

· Broadcast, HTTP, HTTPS and ICMP dedicated ports must be allowed.

· Led Status at the rear of the Evolis printer must be as in the following example: 

Primacy example
Green LED
On = 10Mbit/s
Off = 100Mbit/s

Orange LED
On = Printer connected to network
Blinking = Printer connected and network traffic
is working

 
 8.2.2.    Setting a Fixed IP Address on the Printer  

By default, printers do not have a configured IP address. 
You need to configure it manually. 

 
 8.2.2.1.   Collecting the Required Information  

Make sure you have access to the following information:
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o IP address of your computer network card (ex: 192.168.1.23)
o Subnet mask of your computer network card (ex : 255.255.255.0)

In most situations, you will need to request those settings to IT department or technical
team of the company where you plan to install the Evolis Network printer.

 
 8.2.2.2.   Configuring your Printer IP Address  

For this first step, your printer must be connected to the computer through a USB cable. 

Step 1: To set the address and other settings, use the Card Printer Direct Command Tool (please
refer to section Accessing the ComTool)

Step 2: send commands in the following order:
1. Rip to read the current IP address of the printer and check the compatibility with your
computer IP address
2. Pip;192.168.0.1 (example)
3. Penm;255.255.255.0 (example) to set the Ethernet subnet mask / Renm to read it 
4. If necessary, Pegw;……to set the Ethernet gateway and Pews; …… to set the Ethernet WINS
server. 

Step 3: You can now unplug the USB cable and connect the Ethernet cable. 
Now go to Finishing the Printer Configuration .21
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 8.2.3.    Setting a DHCP Address on the Printer  

You may want to use the DHCP configuration if you use a switch to connect one or various printers
(and/or computers) to a DCHP server (see section Using a Switch).

 
 8.2.3.1.   Configuring DHCP address  

By default, Evolis printer are configured in DHCP mode. But if you have already changed this mode
into a static IP address and you want to go back to a DCHP adress, then follow the procedure below.

Step 1. Connect printer and computer through the USB cable. The EPS must be installed in Minimal
Mode on the computer(s).

Step 2. Configure the printer in DCHP mode. You can choose the configuration that best suits you: 

Option #1: Set the address manually

Use the Card Printer Direct Command Tool (please refer to section Accessing the ComTool)

Be extremely careful with the characters. The presence/ absence of spaces and capital
letters is important. 

Enter the commands:
2. type Rip to read the IP address
3. enter Pip;DHCP
4. Enter Rip;1.The answer must be [IP address] Auto (see the example below) 

5. to configure the subnet mask , enter Penm;255.255.255.0 (example)

Option#2: Reset factory configuration

· From the Comtool:
Type Rmp;E
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It will reset the DHCP configuration and disable the Wi-Fi option (if available)

· You can also reset the configuration through a long push on the switch on/off button of the
printer. 

 Option #3: Enable DCHP mode through the LCD screen 

  

Step 3: Unplug the USB cable and install all the hardware equipment (please refer to diagrams in
section Using a Switch). Make sure the printer is switched on and the Ethernet cables are plugged. 
Make sure to retrieve the IP address provided by the DHCP server to the printer. Then go to
Finishing the Printer Configuration .

 
 8.2.4.    Using a Switch  

 

21
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Use the:
- DHCP protocol if your switch is connected to a DHCP server (Setting a DHCP Address on the
Printer)
- fixed IP address otherwise (Setting a Fixed IP Address on the Printer)

 
 8.2.5.    Adding the Printer to the List  

Once you have set the printer IP address on the printer, you need to add the new printer in the list. 

Step 1: Open the Apple Menu to access to the System preferences>Printers & Scanners:

19

17
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Step 2: Click on + to add the printer.

In the IP tab (or symbol of the world)>Protocol, select HP Jetdirect - Socket : 
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Step 3: In the Address field, enter the IP address of the printer.

Click on Add, then OK.  
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The printer is now shown as online in the printers list:

Step 4: Go to Checking Connection With the Printer

 
 8.2.6.    Checking Connection With the Printer  

There are two ways to check the connection with the printer:

Option #1
Open a webpage and enter the IP address of the printer in the search field and type on Enter. 

The page displayed is the following:

Accessing this page means that your computer is connected to the printer. 
If this page is not displayed, go to Troubleshooting section. 

Option #2 Ping Command
Open the Terminal (Finder>Applications>Utilities>Terminal) and send the ping command:

24
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3. If the answer is as written in the screenshot above, then the ping test is positive and the computer
can communicate with the printer. 
If not, go to Troubleshooting section. 

 
 8.3   Assigning the Driver Version  

To check that the driver was assigned to the printer that you want to use, go to System
Preferences>Printers&Scanners. 

Click on the + button. 
Click on the name of the printer. Go to Use>Select Software and click on Add. 

If the the driver assigned is not the adequate one, click on the Use field and search for the adequate
driver.
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If the driver assigned is not the adequate one, please follow the procedure below:

Step 1: From the computer main menu, click on System Preferences.

Step 2: Select the current printer and click on the + button .
Click on Use>Select Software.

Then select the adequate version and click on OK. 
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 9. Accessing Printing Settings  

There are two ways to access the settings:

Option #1: Your card designing application allows direct access to the driver settings

Step 1: From the software, click on Print. 

· Access in TextEdit:

Click on File>Print

If necessary, click on Show Details and select Printer Features under the Orientation field:
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· Access in Cardpresso:
Go to Print>Print Settings>Advanced Options>Printer Features

For example, to change the ribbon settings:
In Feature Sets>General>Ribbon Type, you can change the ribbon type in the drop-down menu:

Step 2: To save the driver settings, go to Presets>Default Settings and Save Current Setting as
Preset…
You will be able to use the Last Used Settings to print your future jobs.
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Option #2:  The  card designing software does not allow direct access to the driver settings

You can access the driver through a webpage interface (called CUPS). Please follow the procedure
below:

Step 1: Open a webpage and type in the following address: localhost:631/admin

Step 2: The web interface may be disabled, as shown below: 

In this case, activate the interface as follows: go to Finder>Applications>Utilities>Terminal.

In the interface of the terminal displayed, enter cupsctl WebInterface=yes and click on Enter

Step 3: The web interface is displayed:

http://localhost:631/admin
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Go to Printers>Manage Printers and click on the adequate printer:

Step 4: In the Administration menu, select Set default options:

You can now change the settings as explained in chapter Changing Printer/Lamination Module
Properties .32
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 10. Changing Printer Properties  

The different ways to access printing settings are explained in section Accessing Printing Settings
.

 
 Watch this video to understand better the encoding and printing processes of an Evolis
printer: How does a plastic card printer work?

Various softwares may be used to create a design and patterns on the card that you want to print:
- Evolis © applications: Cardpresso, Badge Studio , Edikio Price Tag, etc
- Macintosh® applications: TextEdit.

 
 10.1   General  

Collate: this feature is linked to the printing order (if the software used enables it)

For the other settings, go to the next sections:
- Card Orientation
- Feeder/Hopper

 
 10.1.1.    Rotate  

Use this feature to change the orientation of your design on the card.

Step 1: Keep portrait orientation if your design is oriented vertically and tick landscape orientation if
your design is oriented horizontally. 

Step 2: Rotate each side (front and/or back) by 180°: this is especially useful when your design is
made of a dark color first and then a lighter color. 
In this case, the darker color may bleed onto the light color.
It is also useful when printing with a half-panel ribbon (see section Short Panel Management)

28

https://www.youtube.com/watch?v=X6j7eXwtpdA&feature=youtu.be
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USE CASE #1:
dark and light

colors

The card contains two colors: red (dark color) and yellow (light color). 

Printing result when the rotation was not modified by 180°: 
=> the red color has bled on the yellow color, because the first color printed
was the darker one

Printing result when the rotation was modified by 180°:

=> no color bleeding issue, as the first color printed was the lighter one
(grey color)
The line between colors is frank, compared to the first image:

 

USE CASE #2:
printing dual-

sided cards
with a simplex

 printer
(back-side
rotation)

To print a dual-sided card on a printer that does not have the duplex
module activated, proceed as follows: 
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 10.1.2.    Cards Feeding/Exit  

 It is recommended to use default settings, as they are adapted to the current printer. 
However, for specific printers, changing default settings may be necessary. Details will be
provided in the Use Case sections. 

 
 10.1.2.1.   Card Insertion  

The insertion of the card in the printer is the first step of the printing process. 
 

Default selection: recommended setting according to
the type of current printer
For example, on a Zenius printer, the default option is
the card insertion through the feeder, even if manual
insertion is also a possibility ("Manual feeding" option)

 Feeder: the card is fed using the classic feeder

Automatic selection: the card is fed by using either
the classic feeder  or the manual feeder (as long as your
printer has a manual feeder), depending on the
presence of the card on any of the feeders

 Manual feeding: the card is hand-fed through the
manual feeder

USE
CASE:
using a
Zenius
printer

 

This printer has two card-feeding options: 
- 50-cards input hopper 
- manual feeder
 In case you only need to print one card or two cards at a time, you should  select
Manual feeding. 
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 10.1.2.2.   Card Exit  

The exit of the card is performed at the end of a successful printing process. 

 

Default selection: recommended
setting

 Reject box: printed cards exit in the
reject box, at the rear of your printer, if it
is available.
 This option is also necessary when you
want to use the pre-loading feature
(please refer to  section Card Pre-
Loading)

Output hopper: printer cards exit in
the front output hopper

 
 10.1.2.3.   Card ejected in error  

The ejection of the card is performed at the end of a failed printing process or upon a user manual
action. 

 

Default selection: recommended setting 

Output hopper: rejected cards come out in
the output hopper, at the front of your
printer 

Reject box: rejected cards come out in the
reject box, at the back of your printer or
under it, depending on its design
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 10.1.2.4.   Card Pre-Loading  

 

 This feature is only on the following printers, equipped with a reject box: Primacy and
Elypso. 

Pre-loading means that up to two different cards are used by the printer at the same time: 
- one is in the loading phase 
- another one is in the printing phase

Pre-loading of the card is used to increase the card-feeding speed, whenever the conditions make it
possible.

 Two conditions must be met before using this setting: 
- the Card exit setting must be defined on Reject box
- the ribbon used is a monochrome ribbon

Select On to set the pre-loading of the card. 

The printing process of the card is faster, as the card is ejected at the back instead of the front: its
path inside the printer is only one way. 
In this case, you should install an output hopper on the printer:

As the ribbon used has only one color, the card does not need to go through different passes inside
the printer. 
 

 The reject box has a capacity of 50 cards: please make sure to empty the box before it is
full. 
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 10.1.2.5.   Specific Settings for Kiosk (KM2000) printer  

Card Insertion

Default selection is feeder

Card Exit

Default selection is bezel

Card ejected in error
Default selection is lower reject slot

Feeder configuration

Automatic selection: cards printed are retrieved from feeder 1, then
from feeder 2 when feeder 1 is finished, etc.
Alternate feeding:  one card is retrieved from feeder 1, then one card
from feeder 2, then one card from feeder 3, etc.
None: when Card insertion is set on Bezel

 
 10.1.2.6.   Specific Settings for Kiosk (KC) printers  

KC printers are the following:
- KC Essential
- KC Prime 
- KC Max

According to the the printer specific features and the way they are installed in the self-service
terminal, the user can select different settings:
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Example of a KC Prime in a

self-service terminal

KC Essential/ KC Prime

Card Insertion and exit: 
- on the front side or the rear side on a KC Essential printer

- on the feeder/output hopper or the rear side on a KC Prime printer
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Lower reject slot is also possible on both printers.

Card ejected in error:
Lower reject slot and rear side are possible on both printers. 

- front side is a possibility that is specific to KC Essential printer

- reject box is a possibility that is specific to a KC Prime printer

 
 10.2   Ribbon  

 
 10.2.1.    Ribbon Manual Selection  

Step: Tick Select the ribbon type and choose the type of ribbon according to your wish. 

Available ribbons are the following:

Type of ribbon Description and Use Cases

YMCKO Five-panel ribbon with the following colors: yellow, magenta,
cyan, black and overlay. 
This is the default color ribbon used in Evolis printers. 
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Type of ribbon Description and Use Cases

Compatible printers: Badgy (the ribbon is adapted to the
printer size), Zenius, Primacy, Elypso, KC200/200B

SHORT YMCKO Also called half-panel ribbon
It  has the same colors as the YMCKO ribbon, but its panels are
half the size.
It is used to print half or a third of the card.

YMCKOK 6-panel ribbon with the following colors: yellow, magenta,
cyan, black, overlay, black
Compatible printers:  Primacy, Elypso

SHORT YMCKOK 6-panel ribbon with the following colors: yellow, magenta,
cyan, black, overlay, black
This ribbon has the same colors as the YMCKO ribbon, but its
panels are half the size of the YMCKO ribbon.
It is used to print half or a third of the card.
Compatible printers:  Primacy, Elypso

SHORT YMCKOKO 7-panel ribbon with the following colors: yellow, magenta,
cyan, black, overlay, black, overlay 
Compatible printers: Primacy, Elypso, KC200/200B
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Type of ribbon Description and Use Cases

KO Two-panel ribbon with the following colors: black and overlay
Compatible printers: Zenius, Primacy, Elypso                         

MONOCHROME (black, white,
red, green, blue, metallic gold

and metallic silver)

One-color ribbons
Compatible printers: Zenius, Primacy, Elypso

Hologram  Ribbon Continuous ribbon which applies a edge-to-edge hologram
varnish to increase the security of the card
Not compatible with smart contact cards or magnetic stripe
cards
Compatible printers: Zenius, Primacy

SCRATCH OFF Continuous ribbon which produces a grey area that can be
scratched off
Compatible printers: Zenius, Primacy, Elypso, KC200/200B
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Type of ribbon Description and Use Cases

To use this ribbon:
1. print a text on the card, with the ribbon of your choice
2. in your card designing software, edit an area to apply the
scratch-off. Fill the area with any color. Make sure the area
covers the text printed before. Place the scratch-off ribbon
into the printer and print the scratch-off design

SIGNATURE Continuous ribbon which enables to apply a rectangular area
on cards, where a signature can be written
Compatible printers: Zenius, Primacy

BLACKFLEX Black monochrome ribbon. 
Due to the composition of its ink, this ribbon can be used with:
- standard cards: PVC, PET, PC, 
- and cards that cannot be printed with the traditional
monochrome black ribbon: ABS, paper

Compatible printers : Zenius, Primacy, Elypso, KC200/200B

This ribbon is useful when the printing result with the
traditional black ribbon is not the expected one, even after
changing the concerned driver parameters.  Please refer to
section Front Side Graphical Settings for more details. 
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 10.2.2.    Duplex Mode  

The Duplex  mode enables the user to print your card on the front and back sides during the
same printing job, with no manual action during the printing process.

Front color/ back color With these options, the varnish settings are set by default on Full varnish.
 

To change these settings, please go to sections Front Side Varnish
Adjustment and Back Side Varnish Adjustment.

Front color/ back
monochrome 
Front monochrome/
back monochrome
Front monochrome/
back color 

This option is used when printing on the two sides of the card: you may want to use different ribbon
settings for each side. 
Printers concerned can be the following ones : Primacy, Elypso and Duplex.

As a  consequence, it is:
- visible when your current printer has an integrated flip-over (= duplex) module
- not visible when your printer does not have an integrated flip-over (= duplex) module 

To check the presence of the flip-over module in your printer, go to Comtool (please refer to
Accessing the ComTool)  and enter the Rflo command. If the answer is Enabled, it means the
module is installed.

59
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Step 1: Select the type of duplex mode according to the type of ribbon that you are using:

Ø  You are using a YMCKO ribbon (full or half): 

Type of duplex
mode 

Use Case

Front color/ back
color Each side of the card is printed with different YMCKO panels . 

USE CASE

 The setting used for the Black Panel Adjustment is set on All black dots
for each side. 

Front color/ back
monochrome The front side is printed with the YMC colors and the overlay  will be

applied on it. All black elements on the front side are printed with composite

black . 
The back side is printed with the black color (K panel). No overlay will be
applied to the back side (varnish option is deactivated for the back side). 

Selecting this option will use two YMCKO panels during the printing
process and skip some colors for the back side.  If you do not want to
use your ribbon too quickly, we recommend that you select this

option only if you really need it. 

USE CASE
For the front side: by default, the setting used for the Black Panel Adjustment
is set on No real black printed.
For the back side: by default, the setting used for the Black Panel Adjustment
is set on Black and White, but you can select another option (please refer to
section Black Panel Adjustment).
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Type of duplex
mode 

Use Case

K panel is particularly adapted to barcodes and QR codes. Make sure to insert
them on the back side, with this option.

Front YMC/ back KO The card front side is printed with the YMC colors, and the back side is printed
with the KO (black and overlay) panels.

The only difference with the previous option is that the overlay is applied on
the back side and not on the front side (varnish option is deactivated for the
front side). 

With these options, the varnish  settings are set by default on No varnish on
both sides of the card. 

To change these settings, please go to sections Front Side Varnish Adjustment
and Back Side Varnish Adjustment.

Custom front
monochrome/ back
monochrome
Custom front
monochrome/ back
color 
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It is strongly recommended to avoid printing flat colors on any of the card sides. Always
make sure to add patterns or characters to your flat color.
Indeed, flat color only causes the print head to warm too much as there is no other design
detail to lower the heat of the print head. 
This issue may cause the ribbon to be stuck on the card and torn. 

Ø  You are using a monochrome ribbon

Both sides are printed with the same color and no varnish  option is possible as there is no
overlay panel in the ribbon

Step 2: Check the settings in Front Side Varnish and the Back Side Varnish windows.
Select Full Varnish if you want both sides of the card to have the varnish protection. 

 Never use the varnish  option on the side of a card that is already laminated. 
It would not be useful and would produce various issues, including card jamming, tearing

of ribbon, unsticking of lamination  film, etc.

 
 10.2.3.    Printing Resolution  

Step: Select the type of resolution: 

Resolution Use Cases

300x300 dpi

(size of design in pixels: 1016x648)

Default resolution, adapted to most printing jobs and
printers

600x300 dpi

(size of design in pixels: 2032x1296
size of printing rendering in pixels:

2032x648)

Adapted to printing jobs on most printer, if the size of
your design resolution is bigger

 Finer details can be printed, but the card
printing process may be slowed  down.
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Resolution Use Cases
1200x300 dpi 

(size of design in pixels: 4064x2592
size of printing rendering in pixels:

4064x648)

Only when using monochrome ribbons, especially with a
design of:
- small characters in text areas
- high resolution 

1 dot = 0,12 mm 

 
 10.3   Graphical Settings  

Please refer to the next sections: Front Side/Back Side Graphical Settings

For the specific feature on the definition of the text area, please contact your Evolis reseller or the
Support team. 

 
 10.3.1.    Front Side/Back Side Graphical Settings  

Those settings will enable you to adjust the color panels, so as to get the most optimal printed
result.
The Ribbon details tab provides the name of the ribbon currently detected in the printer.

To enable the back side graphical settings, make sure to enable the Duplex  Mode in the Ribbon
menu (for more details, see section  Front Side and Back Side Settings)

 
 10.3.1.1.   Brightness and Contrast  

Step: Adjust the brightness and contrast of your colors.

Feature Use Case
Brightness of

colour panels

Increases the overall lightness of the image.

Contrast of
colour panels

 Increases the overall darkness of the image. 
 The higher is the contrast, the higher is the printing heat.

47
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 10.3.1.2.   Black Panel Adjustment  

Option #1: A color ribbon is selected to print the current side

The user has two possibilities:
- using a pure black color (RGB code above 253)

- using a mix of colors (yellow, magenta and cyan panels): it is called composite black  

There are three different parameters associated with these two possibilities:

Feature Use Cases
Monochrome

Resin Adjustment no real black printed: the black panel (K) is not used during the printing
process. 
Only composite black is used. 
It is especially useful for designs with only images

Settings: No real black, front side with YMCO panels

Settings: back side with K panel

all black dots : the black panel (K) is used for the whole design (text
area, images)
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Feature Use Cases

Settings: All black dots, front side with YMCKO panels

only black text: the black panel (K) is used only for text areas and barcodes 

Setting: Only black text, front side YMCKO

If you have selected all black dots  or only black text, you may need to adjust the resin
monochrome setting. This setting is directly linked to the print head heat and to the thermal

transfer  technique. 

 In case you want to print barcodes or text areas with small characters, the printing result
must be more accurate.
 You may need to:

- increase the resin adjustment (by default it is set on 10),
- decrease the printing speed. 

Option #2: A black ribbon is selected to print the current side

There are four different halftoning  parameters:
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Feature Rendering
Threshold

Floyd

Dithering 

Clustered

Dithering

When applying pure black color on the card, the monochrome resin adjustment is increased or
decreased in order to improve the density of the black color on the card. 

 
 10.3.1.3.   Printing Black Text: Use of Different Softwares  

This section will compare various software used when printing black text areas, and explain the best
parameters to use in the driver. 

The use case is to print a design that contains a background image and black text area: the image
must be printed in color and the text must be printed in pure black.
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Example of Card Design with Image and Text Areas

Some softwares detect the difference between text areas (bitmap) and images (vectorial) while
others do not. 
Depending on the software you are using to design your card, you will need to set specific settings in
Black Panel Adjustment.

Pre-requisite: add a Card format for Evolis printers

1. Open TextEdit application
2. Go to File> Page Setup>Paper Size>Manage Custom Sizes
3. Click on + and add a new format as follows: 

- width : 55mm 
- height : 86mm 
- top : 0mm 
- left : 0mm 
- right : 0mm 
- bottom : 0mm 

5. Save the new format with the name Card and click on OK
6. Close Text Edit
7. Go to System Preferences
8. Select Printers and Scanners
9. On Default paper size, select Card

--------------------------------

1. Cardpresso
Text areas and images are detected. 

It also works without black dots  on the images. It means that the RGB code used for the image
black areas is under 253. 

Step 1: Do not forget to set the image as a background (clicking and pressing on control key)
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Step 2: There is no need to configure any other setting. Click on File>Print. 

-----------------------------

2.  Preview
This is the default image editor on Macintosh platforms. 
Difference between text areas and images is not detected. 

Step 1: Go to Tools and set the image size in pixels is the resolution that you want to print
(1016x648 or 2032x1296 or 4064x2592) and save it.
For more information on the available resolutions, please refer to section Printing Resolution . 46
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Step 2: For the procedure to define a text area, please contact your Evolis reseller or the Support
team. 

Step 3: Directly from the image icon, right-click and click on Print. 

 
 10.4   Varnish adjustment  

The varnish (= overlay) , is available for all types of ribbons apart from the continuous ribbon (as
it does not have an overlay panel).

The varnish adjustments window allows you to adjust the varnish coating on cards and where to
apply varnish on cards. 
The purpose is to protect the card from UVs and to increase resistance of cards to scratching and
fading up. 

Feature Steps to follow /Rendering
No varnish
No varnish is applied on the
printable area.

As it is not possible to print on a card side that was varnished, use
the No varnish option when you want to print:
1. the "background" pattern in a first printing job
2. then the text in defined areas in a second printing job

https://www.evolis.com/form/support
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Feature Steps to follow /Rendering

Printed card is more
exposed to wear
and tear

 
 When all printing jobs are finished on the card, you may go to Full
Varnish or Custom bitmap option. 

 Full varnish 
 The printable area is covered
with varnish.

Use this option if you have finished printing the patterns and texts
on you card. 

In case you want to check that you have applied an overlay on your
card, check the brightness of the card. 
TIP: A bright card indicates that an overlay was applied, as it reflects
the light of the environment. 

 Custom bitmap/Bitmap
File
 You select a format to apply
the overlay on the card 
 
Applying an overlay with a
custom bitmap is especially
useful when you have a
magnetic or smart encoding
on your card. 

  
 Please contact your Evolis reseller or the Support team. 

USE CASE
You may want to apply a varnish on the back if your card is especially submitted to frictions. 

For example, the repeated insertion in a reader, of a card equipped with encoding  capacities,
may cause scratches to appear. 

Applying the overlay  on both sides of the card will add a useful protection.

You can also adjust the varnish value from 1 to 20. Default value is 10, but you may want to increase
the adhesion of the varnish, for example if the current varnish is too easily removable on the cards
that you previously printed. 

 
 10.5   Magnetic Encoding  

Magnetic encoding uses the following support: a magnetic stripe on the card

Before starting to encode your card, you need to insert the magnetic card in the printer feeder. 

https://www.evolis.com/form/support
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The first card to be encoded is the one that is at the bottom of the cards stack. 

Cardpresso software enables you to print magnetic encoding tracks (please refer to section
Encoding Using Cardpresso) . 
You can also develop your own encoding application thanks to Evolis SDK and the driver settings
(please refer to section Encoding Properties)

 
 10.5.1.    Encoding Using Cardpresso  

Step 1: Insert the magnetic card in the printer feeder (  magnetic stripe on the down-side
and on the right of the printer)

Step 2: From Cardpresso, select the adequate type of magnetic card. Magnetic encoding is available
from XXS version of Cardpresso software. 

Step 3: From the card designing window, click on the View card back button to display the
encoding tracks. 

55
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Step 4: Click one of the tracks to enter the content. 

Step 5: From the right part of Cardpresso software, you can change the source of your track content,
then match your database content with each track. 
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 For more details, please refer to the help available in Cardpresso software.

Step 6: To print the encoded card, go to File>Print and select Magnetic Encoding. 

Step 7: To read the tracks you have just encoded, insert the card and go to the Comtool (please refer
to Accessing the ComTool)
Select the tracks and click on Read track(s).

 
 10.5.2.    Encoding Properties  

Encoding settings in the driver are mostly useful if you plan to develop your own application in order
to use the encoding feature. You will have to use SDK 2.n.  
For more information, please contact the Support team.

Step 1: Change the encoding standard for each track. 

59
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The stripes can be configured in ISO, SIPASS, C2, JIS2 and C4 format.
See the tables below for information on the ISO 7811 and JIS2 (Japanese Industrial Standard)
standards.

ISO 7811 magnetic encoding standards
 

 Stripe #  Separator  Density  Character set  Number of
characters

 Stripe #1 ^ 210 bpi (bits per
inch)

Alphanumeric
(ASCII 32-95) 

79

 Stripe #2 = 75 bpi Numeric (ASCII 48-
62)

40

 Stripe #3 = 210 bpi Numeric (ASCII 48-
62)

107

ISO1 accepts up to 793 alphanumeric characters, from A to Z and from 0 to 9 along with ASCII
characters between 32 and 95.
ISO2 accepts up to 403 numeric characters, from 0 to 9 along with ASCII characters between 48 and
62.
ISO3 accepts up to 1073 numeric characters, from 0 to 9 along with ASCII characters between 48 and
62.

Character set: The “?” character cannot be used
Number of characters: Including the Start, Stop and LRC characters (automatically
handled by the magnetic encoder)

JIS2 magnetic encoding standards
 Stripe # Separator Density Character set Number of characters

 Stripe #1 ^ 210 bpi Alphanumeric
(ASCII 32-95)

79

The C2 and C4 configurations relate to custom mode and are reserved for future use.
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The SIPASS configuration accepts 21 characters, from 16 to 127 (ASCII characters).

 Make sure not to apply an overlay  on the magnetic stripe. If the overlay is applied on
the magnetic stripe, the reading of the encoded information may not be well performed.
To apply an overlay of custom bitmap file on the card (with no overlay on the magnetic
stripe), please refer to section Varnish adjustment

 Before starting the encoding of a card side, always check the parameter that was selected
in Varnish type: "no varnish" or "custom bitmap" are correct options whereas "full
varnish" is not a good option. 

Step 2: Two types of coercivity are available for the magnetic stripe. 

With Evolis cards, the following types are available:
 Type of coercivity  Meaning 

 Hico (high coercivity)  high immunity level 
 Loco (low coercivity)  low immunity level 

 
 11. Accessing the ComTool  

The Comtool is used to retrieve basic information about the printer, send commands, upgrade the
firmware and manage the basic encoding features if your printer is equipped with the encoding
capacity. 

Step 1: To access the Comtool, go to System Preferences in the Apple menu.

Step 2: Click Printers & Scanners.
Select the printer in the list.

Click on Options and Supplies>Utility>Open PrinterUtility. 
The Comtool is displayed. 
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From this window, various features are accessible: 
- identifying the printer details
- sending direct commands (escape commands) to an Evolis printer 
- testing magnetic encoding feature (if a magnetic encoder is installed)
- upgrading printer firmware

 If the Comtool is not functional (this may be the case if your OS version is >10.12), you will
need to install it separately.
 Please contact the Support team to access the application file and installation

explanations.
 In case you are working on Mac OS 11 (Big Sur), the Comtool is not available. 

 
 11.1   Sending Direct Commands in the Comtool  

Use the Command field to communicate with the printer.

https://www.evolis.com/form/support
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The most frequent commands are:
R means Reading
P means Programming

Some examples of commands:
 Command  Meaning  Good answer

 Rfv  Read Firmware Version  Firmware number is displayed
 

 Rip  Read IP Address  IP address of the printer is
displayed

 Stt  Sequence Technical Card  The card is printed and ejected. 
 The answer must be OK.

 Pip;192.168.0.1 (example)  Program the IP address  The new IP address is configured
and the answer must be OK. 

Rflo  Read the status of flip-over
module 

 ENABLE => the module is active
 DISABLE => the module is not
active

 Sa  Sensors adjustment  The sensors adjustment is
checked.
 The answer must be OK.

TROUBLESHOOTING - Possible wrong answers are: 
ERROR CDE => please check the command 
Unable to communicate with printer => please check that connection cable is well plugged  both
on the computer and the printer

In this tool, you can also read and encode the magnetic tracks when an encoding module is installed
and a magnetic card is inserted in the printer. 
For more details, refer to section Magnetic Encoding  and Track Settings.

 
 11.2   Upgrading Firmwares in the Comtool  

This procedure requires an Internet connection to download the latest updates from Evolis servers.

PRINTER FIRMWARE

Option #1: your version of MAC OS is under 10.12
1. Download the printer firmware file to your hard disk from the Download section of Evolis
website>Support and Drivers.
2. Connect your printer to your computer and switch it on.
3. From the Comtool (procedure to access is explained in section Accessing the ComTool)
click the Upgrade button. 
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8. Search the file downloaded to your hard drive, then click Open to start the upgrade process. 
9. The on-off switch on the control panel of the printer should flash during the firmware update.
Do not switch off the printer during this process. 

Option #2: your version of MAC OS is 10.12 or higher
The printer maintenance tool (Comtool) may not be installed by default on your computer. Please
contact your Evolis reseller or the Support team.

LCD FIRMWARE AND GRAPHIC RESOURCES

1. Download the LCD firmware file to your hard drive from the Download section of Evolis
website>Support and Drivers.
2. Connect your printer to your computer and switch it on.
3. From the Comtool (procedure to access is explained in section Accessing the ComTool)  click
the Upgrade button. 
Search the file downloaded to your hard drive: firmware file (.firm) or graphic resources (.lcdbmp).
4. When prompted by the program, follow the instructions to select the printer and start the
operation.
The firmware transfer is in progress. Wait for the Ready status to appear on the LCD screen.

To check the firmware is well installed, go to the Comtool (please refer to Accessing the ComTool
) and send a Rfv command to the printer. The answer must be the firmware version that you just
installed. 

 Only the upgrade is possible. It is not possible to downgrade the firmware version. 
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 12. Troubleshooting  

This section aims at listing the steps needed to solve specific issues. 

 
 12.1   Connection Issues  

· Printing job is not successful

1. Check that you have selected the right printer in the Print window of your application. 

2. Check the connection with the printer (Checking Connection With the Printer)
If it is not successful, check the IP address of the printer is on the same network range as the
computer.

· Ethernet cable is not detected 

If...  Perform the following actions
§  Checking Connection With the Printer is not

successful 

§ The printer Ethernet port has a static orange
color (it is not blinking nor green colored)

 1. Change the Ethernet cable 

2. If using a switch, change the port of the cable

3. Check your computer configuration (the
Ethernet card must be enabled and its driver
must be up to date)

4. Restart the printer

· Printer detection has failed 
- check the firewall and antivirus policy: port 9100 must be allowed, as well as multicast
 - the address of your computer must also be a IP/DHCP one

 
 12.2   Printing Issues  

 
 12.2.1.    Faded Colors  

This type of result (faded colors) may be caused by using a wrong power supply.

Please refer to your printer User Guide to check the supply power that is adequate. 
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 12.2.2.    Torn Ribbon  

Step 1: Proceed to to fix the torn ribbon.

Use tape to put the panels  back together:

Step 2: Solve the issue to avoid another tearing of the ribbon. 

Various checkings may solve the issue: 

Type of checking Steps to follow

 Check firmware version From the Comtool, enter Rfv command.
If the command returns a wrong answer, proceed to printer
firmware update (Upgrading Firmwares in the Comtool)

 Check the printer sensors
working

From the Comtool, enter the Sa command. 
If the command returns a wrong answer, please contact your
Evolis reseller or the Support team. 

 Check offsets settings The ribbon is torn if a hot printhead goes down on the ribbon
when there is no card under it.
Please contact your Evolis reseller or the Support team.

 Check temperature values
applied in the driver

The temperature may have been pushed to the max for the
black panel (when printing a barcode for instance). 
For other designs, this setting may cause ribbon tearing issue.
As a reminder, default value for monochrome resin
adjustment parameter is 10.

 Check the ribbon A faulty consumable may be the cause of the issue. 
Replace by a ribbon from a different batch lot number.

  Check printhead serial number A printhead replacement or a mistake may have sent a wrong
value to the printhead.
In the Comtool, check that the answer to the Rkn command
matches with the barcode stuck on the printhead.
If the answer does not match, send the value displayed on the
barcode through the Pkn command or using the wizard.
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Type of checking Steps to follow

 Check card surface / quality Check the card freshness: a simple test consists in bending
the card. 
With time and/or bad storage conditions, cards become
brittle and their surface is not porous anymore.

 
 12.2.3.    Unreadable Barcode  

In specific cases, the surface quality of some cards do not allow a good rendering of the barcode
printing, which makes it unreadable by the appropriate scanner. 

Example:

Resin adjustment set to 10
Monochrome printing speed set to 10

The barcode was printed using Evolis Printing default settings.

Procedure to improve the printing:

Step 1: Increasing the resin adjustment improves the result.

Resin Adjustment set to 16     Resin Adjustment set to 18

Step 2: If Increasing the resin adjustment does not produce a better print quality, decrease the
printing speed by dropping 2 points at first (go to section Advanced Parameters), :

Resin Adjustment Set on 20 
+ Slower Printing Speed 

 A slower printing speed produces a better ink adhesion on the card. 

For an even better result, you can use a blackflex ribbon combined with the default settings of the
Print Center (resin adjustment and printing speed both set to 10). 
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